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MASTERSPEC Specification System

License Agreement

ThisisaLicense Agreement, not a sales agreement issued by Architectural Computer Services, Inc. (ARCOM) for The American Institute of
Architects (AIA). Itisalegally binding Agreement between you and the AIA. Thislicense gives you the right to use the MASTERSPEC
Specification System for a one-year period. By signing the order form, you are agreeing to the terms and conditions that follow. Y our order
cannot be processed until we receive this signed Agreement and your full payment.

Termsand Conditions

Throughout this License Agreement the word " System” refers to the AlA-copyrighted MASTERSPEC Specification System, comprised of the
MASTERSPEC specification text and supporting documentsin all computer formats, hard copy, the computer distribution CD-ROMs and
diskettes, the MASTERSPEC User's Guide, and periodic updates.

The MASTERSPEC Specification System is copyrighted by the AIA and is updated quarterly by ARCOM for the AIA. MASTERSPEC isa

registered trademark of the AIA.
Governing Law

This Agreement will be governed in all
respects by the laws of the Digtrict of
Columbia.

Your Right to Usethe System

You are authorized to use the System
provided that:

1) You maintain an active license for
which no fees are more than two
months overdue.

2) Y ou have not violated the terms and
conditions of this License.

3) ARCOM has not terminated this
Licensefor the AIA.

ARCOM, for the AIA, grantsyou a
nonexclusive and nontransferable license to
use the System solely and exclusively within
your organization. The System may be used
only to produce office-edited versions (office
masters) and construction project
specifications for use on specific construction
projects. Y ou may network the System so it
can be used on other computers or terminals
within your organization so long as al useis
limited to the single address indicated on the
order form and each individual who uses the
System is familiar with the terms of this
Agreement (a copy isincluded in the
MASTERSPEC User's Guide). Y ou may not
(i) alow access to the System to anyone
outside of your organization; (I1) decompile,
reverse engineer, decrypt, disassemble, or
otherwise reduce the software in the System
into hard-copy form; nor (iii) otherwise copy,
distribute, rent, loan, disseminate, publish,
sdl, or transfer any portion of the System.

Y ou may reproduce and distribute outside of
your organization a project specification
produced through use of the System provided
that distribution of the specification is solely
and exclusively in connection with asingle
construction project for which the
specification was originally produced. You
may not resell, publish, or otherwise
distribute any such specification for any other
purpose, such as, but not limited to,
advertising purposes or general informational
or educational services without prior
permission from the AIA or ARCOM. The
AlA and ARCOM retain all rightsto the

System not specifically granted by this
Agreement.

Disclaimer Although the information
presented in the System is set forth in good
faith and believed to be correct, the AIA and
ARCOM make no representation or warranty
as to the completeness or accuracy thereof.
Information is supplied on the condition that
you will make your own determination asto
its suitability for your purposes before its use.
In no event will the AIA or ARCOM be
responsible for damages of any kind resulting
from the use or reliance on information or the
materials, products, manufacturers, systems,
or applications to which information refers.
Nothing contained herein is to be construed as
arecommendation to use any materials,
product, manufacturers, process, system, or
application.

THE AIA AND ARCOM MAKE NO
REPRESENTATION OR WARRANTY
HEREUNDER, EITHER EXPRESS OR
IMPLIED, OF FITNESS FOR A
PARTICULAR PURPOSE WITH RESPECT
TO INFORMATION OR THE
MATERIALS, PRODUCTS, SYSTEMS, OR
APPLICATIONS TO WHICH THE
INFORMATION REFERS.

IN ADDITION TO AND NOTWITH-
STANDING THE ABOVE, IN NO EVENT
SHALL THE AIA, ARCOM, NOR ANY
THIRD PARTY WHO HAS
PARTICIPATED IN DEVELOPING,
MARKETING, OR DISTRIBUTING THE
SYSTEM BE LIABLE FOR ANY
CONSEQUENTIAL OR SPECIAL
DAMAGES OR FOR ANY LOSS OF
PROFITS INCURRED BY YOU OR ANY
THIRD PARTY IN CONNECTION WITH
OR ARISING OUT OF THE USE OF THE
SYSTEM.

Y ou understand and agree that you must
review and edit the System before
incorporating it into a project.

You also agree that if you find errors or

ambiguitiesin the System, you will notify
ARCOM promptly.

Updates ARCOM will continue to develop
new sections and update existing sections of
the System. Your license fee will cover

| HAVE READ AND AGREED TO THE ABOVE TERMSAND CONDITIONS

services, updates, and enhancements issued
by ARCOM during the term of this License.

Refund Policy If you are not satisfied
with the System, you may cancel this License
within 30 days of receipt of the System by
returning all components of the System to
ARCOM accompanied by aletter on your
letterhead certifying that al copies that have
been made are returned or destroyed and that
the System is not being used in any form.
Thelicense fee, less a 15 percent service
charge, will be refunded. Refunds will not be
provided for cancellations made more than 30
days after receipt of the System.

Y ou may exchange damaged components of
the System within 30 days of receipt at no
charge, except when damage results from
improper usage.

Termination This License will
automatically terminate at the end of one full
year from the time you receive the System
unless you renew the License by paying an
annual renewal fee. ARCOM will send you
an invoice for the renewal fee. If thisLicense
isterminated for any reason, you agree to
discontinue using the System, including office
masters derived from the System. You
further agree to return to ARCOM or destroy
al components of the System and to certify in
writing that the System has been removed
from your continued access and use, including
al copies and office-edited versions or
"masters" derived from the System, and that
the System has not been made available for
use by any other party. Printed project
specifications you create from the System
during the term of this license may be used
after termination.

Changesin Termsand Conditions
ARCOM reserves the right to revise prices
and the System at any time and to revise the
terms and conditions of this License on three
months' notice. ARCOM will notify you of
revisions through direct correspondence or by
publishing an announcement of arevision
with one or more system updates, in one or
more trade journals, or AIA, MASTERSPEC,
or ARCOM newsletters.

Authorized X

Signature Date Signed
Print Name

and Title Firm Name

-iv -



Chapter 1
Introduction to MASTERSPEC” and ARCOM

MASTERSPEC

MASTERSPEC is aproduct of The American Institute of Architects (AIA) and is produced
and published for the AIA by ARCOM. MASTERSPEC has been the specification system
of choice for more than 30 years. Currently, more than 10000 design firms, developers,
contractors, manufacturers, institutions, and government agencies use MASTERSPEC.
ARCOM Master Systems are the specification products produced by ARCOM that include
the MASTERSPEC Specification System and ARCOM SPECWARE- specification
enhancement software.

MASTERSPEC is recognized worldwide as the most compl ete, technically correct, and
thoroughly reviewed commercial master specification system available. Insurers offer
discounts on professional liability insurance to MASTERSPEC Licensed Users. Current
litigation frequently relies on MASTERSPEC as the representative standard of professional
care.

Endorsements

The following organizations endorse MASTERSPEC and participate in the MASTERSPEC
Review Committees:

. AlA  The American Institute of Architects
. ACEC American Consulting Engineers Council
. ASID American Society of Interior Designers

. ASLA American Society of Landscape Architects
. CASE Consulting American Structural Engineers
. NLA National Landscape Association

. NSPE National Society of Professional Engineers

MASTERSPEC also has strategic alliances with the Construction Specifications Institute
(CSl) and the International Interior Design Association (11DA).

Review Committees

New and updated MASTERSPEC sections are reviewed by an independent committee of
MASTERSPEC Licensed Users. The committees meet quarterly for two daysin the
ARCOM Alexandria, Virginiaoffice. The AIA and the endorsing organizations fund these
committees. Current committees include the following:

. MASTERSPEC Architectural Review Committee (MARC)
. MASTERSPEC Engineering Review Committee (MERC)
. MASTERSPEC Interiors Review Committee (MIRC)
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. MASTERSPEC Landscape Review Committee (MLRC) by correspondence

MASTERSPEC is aso reviewed by manufacturers, product and industry groups, and
standards organizations on invitation from ARCOM.

MASTERSPEC Libraries

MASTERSPEC isavailable in distinct full-length section libraries organized by design
discipline. Each library is updated quarterly.

. Architectural/Structural/Civil A/SIC
. Structural/Civil S/C

. M echanical/Electrica M/E

. Electrical E

. Interior Construction IC

. Interior Construction Supplement to A/S/C ICS

. Furnishings F

. Landscape Architecture LA

MASTERSPEC Formats

Each library is divided into the following three formats:

. Full Length The most regularly used sections and
frequently encountered conditions for arange of project sizes
and types.

. Short Form Short Form sections are condensed from

and compatible with MASTERSPEC full-length sections.
Short Form sections include alimited range of products,
streamlined material and quality-control requirements, and
concise specifying methods.

. Outline Outline specifications for preliminary project
use.

MASTERSPEC Versions
Each library also has two versions:

. Basic The most regularly used sections and
frequently encountered conditions for arange of project sizes
and types.

. Supplemental Sections where the subject matter is

limited in scope and the work is more specialized or custom
than covered in Basic.

Instructions for your specific MASTERSPEC library and version are included in Chapter three.

Other MASTERSPEC Specification Products

Other MASTERSPEC specification products are available in three abbreviated specification
versions that are updated every two years. INTERIOR DESIGN and FURNISHINGS
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include the Cover, Evaluations, Section Text, and Drawing Coordination Checklist.
SMALL PROJECT includes only the Section Text.

MASTERSPEC A short-form specification for retail, light-

INTERIOR DESIGN" commercial, Hospitality, institutional, office fit-out, and
renovation projects.

MASTERSPEC Specifications for less complex projects

SMALL PROJECT”

MASTERSPEC

FURNISHINGS

Supporting Documents

Each Basic, Supplemental, and Short Form MASTERSPEC section includes the following
supporting documents. Each INTERIOR DESIGN section includes the first four documents.

Cover Describes the content of the section text; related
products and work, including products that could be inserted into the
section if required, similar work normally specified elsewhere; and
closely related work specified in other sections. Includes summary of
changes in the update.

Evaluations Describes characteristics and criteriafor specifying the
products and materialsincluded in the section. Includes editing
instructions referenced in editor's notes in the section text; the scope
of the section, a description of product characteristics; special design
and detailing considerations, if applicable; referenced standards;
suggested reference materials; and alist of manufacturers. Product
comparisons are included in some sections.

Section Text In three-part format with editor's notes, alternative text, in-line
optional text, and insert notes.

Drawing Drawing requirements organized and related to the Coordination

section content. Indicates items that should be Checklist shown on the

drawings because they are not in the
section text.

Specification Includes alist of specification sections and

Coordination requirements that relate to the section content.

Checklist Provides alocation for indicating items that will be furnished

by the Owner; how to apply allowances, unit prices, and alternates to
the section, if applicable; and other specification sections that may
have requirements applicable to the section. This checklist is not
included in the supporting documents for INTERIOR DESIGN.

Editing Assistance

MASTERSPEC is the only complete master specification system available. The
Evaluations provide editing instructions for each specification section as well as product
comparisons; alist of national manufacturers; reference standards; references; and a
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discussion of the section topic and graphics, where appropriate. Sectionsinclude editor's
notes with instructions for editing and selecting aternative text, in-line optional text, and
insert notes. All section text is displayed for your review and editing by any combination of
the methods listed below. Editor's notes and units of measure appear on-screen in color.
Editor's notes are in hidden text and may be toggled on and off in your word processor.
Other guide specification systems include numerous blanks in brackets where text isto be
inserted, but few editing instructions.

Y ou can edit MASTERSPEC using your word processor, your word processor enhanced
with MASTERWORKS, the LINX automated specification editor, or any combination of
these tools. Instructions for editing with your word processor are in Chapter 2. Instructions
for editing with MASTERWORKS are in the MASTERWORKS User's Guide. Instructions
for editing with LINX arein an on-linetutorial. LINX only operates with the full-length
Basic and Supplemental Libraries.

ARCOM

ARCOM isaunique firm of architects, engineers, computer scientists, specification writers,
editors, technical support personnel, product representatives, and marketing staff. ARCOM
began in 1972 as adivision of an architectural firm in Salt Lake City, Utah, offering a
MASTERSPEC editing service and the distribution of MASTERSPEC on magnetic tape to
larger architectural and engineering firms.

When design firms began to use minicomputers and then personal computers, ARCOM
devel oped word-processor versions of MASTERSPEC and started an automation service for
the AIA. In 1988, the AlA selected ARCOM as the sole source for MASTERSPEC
quarterly updates. In December 1994, the AlA selected ARCOM to assume all
responsibilities of MASTERSPEC. On January 1, 1995, the staff of the AIA Professional
Systems Division and all research, writing, editing, marketing, sales, production, and
support of MASTERSPEC transferred to ARCOM.

ARCOM has officesin Salt Lake City, Utah, and Alexandria, Virginia. The Salt Lake City
office includes administration, accounting, word processing, programming, production,
fulfillment, technical support, marketing, and sales functions. The Alexandria office
includes specification research, writing, editing, word processing, technical support, and
MASTERSPEC Review Committee support. The MASTERSPEC Technical Library is
located in the Alexandria office.

ARCOM SPECWARE"

ARCOM SPECWARE isthe family of specification enhancement software provided by
ARCOM to MASTERSPEC Licensed Users. SPECWARE includes the following:

MASTERWORKS® Software that enhances your word processor to simplify editing of
alternative text, select options to keep or delete, insert required text,
and add project notes. The Multi File features automate spell
checking, searching and replacing, formatting, and other text
appearance functions. Specification output formats include project
manuals, sheet specifications, drawing notes, and outline
specifications. MASTERWORKS can also automate headers and
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LINX?

footers, reports, and tables of contents.

A stand-alone automated editor for MASTERSPEC that
operates on standard full-length MASTERSPEC sections in the ARCOM
Structured Text” database format. Text elements in each section are linked
together hierarchically and semantically. All linked dependent text elements
are marked for deletion when a parent text element is marked for deletion.
Thisdlowsfor easy removal of large quantities of text. LINX includes an
interactive question-and-answer edit and an on-screen edit (including
manual editing and override of system edits, automatic edits, and translation
to aword processor format of your choice). LINX includes an extensive on-
line help system with access to al MASTERSPEC supporting documents as
help files and tutorials while you are editing.
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Chapter 2
Installing and Editing MASTERSPEC

Introduction

MASTERSPEC is a copyrighted text database. Y our License Agreement authorizes you to
make as many copies as you need for one office location. You are also authorized to make
one additional copy for backup purposes. Y ou do not have authorization to make copies for
any other purpose. If your firm has more than one office location, you must have a separate
license for each location. For more information, refer to the Terms and Conditions in your
License Agreement.

MASTERSPEC is not a software program. MASTERSPEC is a database of specification
filesfor use with your specific word processor. All specification filesand ARCOM supplied
macro files are accessed through your word-processor.

MASTERWORKS isan ARCOM software program that must be installed if you want to
take advantage of the editing and automation tools provided. Currently, this applicationis
available for Microsoft” Word 97/2000, Microsoft Office 98/2001 for Macintosh and
WordPerfect 8/9.

MASTERSPEC CD-ROM Folder Structure and Description

The MASTERSPEC CD-ROM's are divided into folders and subfolders similar to a hard
disk. There arethree main folders on the CD-ROMs, one for specification files (Mastspec,
Intdesgn, Outline, or Smalproj), one for the GSA specification files and one for software
(Specware). A fourth folder named Adobe on the MASTERSPEC and INTERIOR DESIGN
CD-ROMs contains the Adobe Acrobat Reader software.

The Mastspec folder (Figure 1) has folders for supporting documentsin Word 2.0
(Word\Suptdocs) and WordPerfect 5.1 (Wp\Suptdocs), tables of contentsin Word 2.0
(Word\Tocs) and WordPerfect 5.1 (Wp\Tocs), and folders for specifications in the following
word processor formats:

*  Word 2.0 (Word\Word2)

* Word 6/7/95 automatically numbered sections (Word\Word6_7)

*  Word 97/2000 for Office 97/2000 automatically numbered sections (Word\Word97)
*  WordPerfect 5.1 (Wp\Wp51)

*  WordPerfect 6.1/7/8/9 styled sections (Wp\Wp6_7_8)
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--l:I Ward
-0 Wp
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--I:I kacintsh

----- JUsrguide
-1 Updinst
Figure 1 - MASTERSPEC CD-ROM Folder Structure

On al MASTERSPEC CD-ROMs, the Specware\Mworks folder contains the
MASTERWORKS software and installation program. MASTERWORKS must be installed
to use the editing and automation tools that enhance your word processor's capabilities. See
Chapter 1 "MASTERWORKS Installation™, in the MASTERWORKS User’ s Guide.

Onthe INTERIOR DESIGN and SMALL PROJECT CD-ROMs (Figures 2, 3, and 4), the
Intdesgn, and Smal Proj folders have tables of contentsin Word 2.0 (Word\Tocs) and
WordPerfect 5.1 (Wp\Tocs), and specification files in the following word processor formats:

* Word 6/7/95 automatically numbered sections (Word\Word6_7)
*  Word 97 for Office 97 automatically numbered sections (Word\Wor d97)
»  WordPerfect 6.1/7/8 styled sections (Wp\Wp6_7_8)

The INTERIOR DESIGN CD-ROM dso has folders for the Adobe Acrobat Reader software
(Adobe) and supporting documentsin Word 2.0 (Word\Suptdocs) and WordPerfect 5.1
(Wp\Suptdocs).

= |ntdezgr
| dudoks
-] Intdeegn
- whard
—1 Suptdocs
| I oos
—1 ‘Wordb_¥
1 'wWoard37
= 1 whp
__ | Suptdocs
| Tocs
—1 WRE_T_8 5 _|ngtalling and Editing MASTERSPEC
=] Speciare
__ | Mworks



Figure 2 — INTERIOR DESIGN CD-ROM Folder Structure

= amalpro
_1 Smalproy
- _| 1_.-_:',:,-,:|
{2 Toes
] "whande_7
] "wandd?
=i
] Toce
] WpE_T_8
= S pEcavane
] Mworks

Figure 3 - SMALL PROJECT CD-ROM Folder Structure

MASTERSPEC Naming Convention

Each MASTERSPEC section is numbered and named according to CSI/CSC's 1995
Master Format. Each library table of contents on your CD-ROM lists the section number
and title for al sectionsin that library. Y ou can print the table of contents for reference.

Section Text

. fl_ Full Length Formats
. s  Short Form Formats
. ot Outline Formats

. id  INTERIOR DESIGN

. sp_  SMALL PROJECT

Supporting Documents (Available for MASTERSPSEC Basic, Supplemental, and
MASTERSPEC INTERIOR DESIGN specifications.)

. cv_  Cover

. cvs  Short Form Cover

. ev_  Evaluations

. evt  Evaluations, Table

. eva Evauations, Appendix A, etc.

. dc_  Drawing Coordination Checklist

. st Specification Coordination Checklist (not in INTERIOR
DESIGN)

GSA Documents

MASTERSPEC Division 1 Sections may not be used for U. S. Government projects without
extensive editing. There are significant differences between Government and private
acquisition and contracting practices. For this reason the General Services Administration
has developed GSA Division 1 Sections to correspond, where practical, in subject matter,
title and section number with the 1999 drafts of MASTERSPEC Division 1 sections. The
documents are located on the CD-ROM in the GSA folder. A readme.txt fileisincluded in
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the folder to explain the similarities and differences between the GSA and MASTERSPEC
Division 1 sections.

Adobe Acrobat Reader

The ADOBE folder contains Adobe Acrobat Reader software. This softwareis used to view
Adobe pdf files. Thereis currently one pdf file used in the MASTERSPEC full-length
specification supporting documents (08710evp.pdf). To view thisfile, the Adobe Acrobat
Reader software must beinstalled. Instructions are in 08710eva.wpd or 08710eva.doc.

Y ou do not have to install the Adobe Acrobat Reader software to use MASTERSPEC.

MASTERSPEC System Requirements

Recommended computer system requirements to install and use MASTERSPEC libraries
and versions:

* Microprocessor: Intel (or compatible) 80486 or Pentium™ (Pentium recommended).
*  Operating System: Windows 9.x-Me, Windows NT 4.0 or Windows 2000

*  RAM (Random Access Memory): Minimum 16 megabytes for Windows 3.1/9x, or 32
megabytes for Windows NT/Windows 2000. (64 megabytes recommended)

* Hard Disk Space: Minimum 30 megabytes.

«  Word Processor: Microsoft Word or WordPerfect" to edit your MASTERSPEC files
and run MASTERWORKS.

Getting Started

Y ou may create a master folder and copy all section files from the MASTERSPEC CD-
ROM, or you may create a project folder and copy only those sections required for the
project.

Remove the "read-only" attributes from the files in the MASTERSPEC master folder.
"Read-only" attributes allow usersto view, but not alter information. To change these
attributes, perform the following tasks:

* Inthe MASTERSPEC master folder, click Select All from the Edit menu.
» Click Properties from the File Menu in File Manager or Windows Explorer.
» Desdlect Read Only, and click OK.

Open and print the table of contents from the MASTERSPEC CD-ROM for reference.
Select the sections required for your project. The table of contents will appear in the Tocs
subfolder for each word processor folder (e.g., WordPerfect, Microsoft Word).

Copy the selected files for the project into the newly created project folder. Y ou may use
File Manager, Windows Explorer, or your word processor to copy the files.
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Creating Project Specifications

Y ou can create project-specific specifications with MASTERSPEC using the following
steps:

For each Section:

Note: When you delete a paragraph, you must also delete all the subparagraphs or they will
be incorrectly subordinate to the preceding paragraph.

Review help, reference, and tutorial information in the supporting documents in hard
copy reference manuals or on-line with MASTERWORKS.

Review editor's notes included to help select and edit alternative text. These notes
appear in blue and are in hidden text. They will not print unless the hidden text option is
turned on.

Select from alternative text and delete inapplicable article titles, paragraphs, and
subparagraphs.

Select optional text (options) in boldface and in brackets ([ ]) and delete inapplicable
options.

Insert required text where instructed by insert notes (notes) in boldface and in angle
brackets (< >). Insert other project-specific text.

For a proprietary specification with manufacturers and products listed, select
manufacturers and products where instructed, add additional manufacturers and products
as appropriate, and retain requirements that define salient features.

For anonproprietary specification with manufacturers or products listed, select
manufacturers and products where instructed, add additional manufacturers and products
as appropriate, retain and add to requirements that define salient features.

For anonproprietary specification that is descriptive only, delete manufacturers and
products, retain and add to requirements that define salient features.

Select units of measure to remain by choosing either English (IP) units shown in teal or
SI (metric) units shown inred. You may also leave both units of measure.

Edit headers and footers.
Sdl ect section format.

For the Project:

Print all sections.

Produce and print the table of contents.
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Editing in WordPerfect” 6.1/7.0/8.0/9.0

The WordPerfect sections contain editor's notes formatted as hidden text. To benefit from
theinstructions in the editor's notes, you should always toggle hidden text on while your are
editing on-line. Otherwise, the editor's notes remain hidden. To turn on hidden text, select
the View menu then click Hidden Text.

Supporting Documents

If you are using MASTERSPEC Full Length, Short Form sections or MASTERSPEC
Interior Design sections, you should review the help, reference, and tutorial information in
the supporting documents for each section. The supporting documents are available in hard
copy and on-line using a browser.

The on-line supporting documents (Cover, Evaluations, and Drawing and Specification
Coordination Checklists) on the CD-ROM arein HTML only. You will be able to access,
review, copy and print them with LINX, MASTERWORKS, or your browser.

Inserting Text in WordPerfect

The MASTERSPEC styled sections make it easy to insert and remove text in your
specifications. WordPerfect alows you to turn on reveal codes to display the formatting and
style codes in the section.

Turn on reveal codes to see the exact cursor location in the reveal codes window.
» Select the View menu.

» Click Reveal Codes.

Turn on hidden text to display the editor's notes.

» Select the View menu.

* Click Hidden Text.

Now you are ready to insert new text. Because the styles are linked together, you can begin
entering text when you place the cursor at the end of the previous paragraph and press
(Enter). If you want to change the paragraph level, place the cursor anywhere within the
new text and do the following:

» Select the For mat menu.

* Click Styles.

» Scroll down the Style List box and highlight the desired paragraph level.
* Click Apply.

To add ablank line above the paragraph, place your cursor at the end of the previous
paragraph and:
* Pressthe Enter key then press the Backspace key.
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To remove an extrablank line below the new paragraph, place the cursor at the end of the
new paragraph and:

Press the Right Arrow key, then press the Delete key.

Adding Custom Editor's Notes

Specia care must be taken when inserting custom editor's notes. To insert new editor's
notes as described in "Inserting Text in WordPerfect" above, type the text of the editor's
note. With the cursor in the text, apply the CMT style. If thereis no blank line after your
editor's note, place the cursor at the end of your editor's note and press Enter to insert a hard
return. Your editor's note will appear like the other editor's notes. However, when you turn
hidden text off, all the editor's notes will disappear except your custom note. If you select
your note with the mouse and apply hidden text attributes, you will have an unwanted blank
line when you turn hidden text off. Y ou will not be able to get rid of thisline. Follow these
steps to convert your custom editor's notes to hidden text:

» Turnreveal codes on.
» Placethe cursor at the end of the previous paragraph.
* Pressthe Right Arrow key once to move to the right of the Style End code.

*  While holding down both the Control key and the $hift key, press the Right Arrow key
twice or until you have selected the Beginning Style code of the first paragraph after
your custom editor's note.

» If your custom editor's note consists of multiple paragraphs, select all paragraphs.

* While holding down the Shift key, press the Left Arrow key twice. All your custom
editor's notes and surrounding codes should now be selected.

» Select the Format menu.

* Choose Font.

» Placeacheck mark in Hidden.
* Click OK.

Y our custom editor's note is now in hidden text and should have the proper spacing when
hidden text is on or off.

Printing Editor's Notes in WordPerfect

There are two advantages to editor's notes being in hidden text as opposed to WordPerfect
comments. Thefirst isthat you can see the editor's notesin any view if you select Hidden
Text from the View menu. The other is printing the editor's notes. The rule for editor's
notes in hidden text isthat "if you can see them, you can print them." To print editor's notes,
turn hidden text on then print the section.
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Changing Fonts, Margins, and Other Formatting Features

One of the advantages of styled sections s the ease of making formatting changes. To
change the font in the entire section:

» Sdlect the Edit menu.

» Choose Select then All, or press (CTRL+A).

» Select the Format menu.

» Choose Font.

» Choose the desired font then click OK.

If you want to change the editor's notes style font for appearance or emphasis, follow these
steps:

» Select the Format menu.

» Choose Styles.

e ChooseCMT gtyle.

» Click Edit.

* Inthe Styles Editor dialog select the For mat menu.
e Choose Font.

» Select the desired font then click OK.

* Click OK inthe Styles Editor.

* Click Closeinthe StyleList diaog.

All editor's notes in the current section are now in the font you selected. A similar
procedure is used to change margins, change colors, or make other formatting changesin the
section. To change the top and bottom margins, follow these steps:

To delete existing margins:

Select the For mat menu.

Choose Styles.

Choose Document Style.
Choose Edit.

In the Styles Editor dialog, note the Top and Bottom margin codes; drag them out of
the dialog with your mouse to delete them.

To set new margins:
» Select the Format menu.

* Choose Margins.
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» Change the Top and Bottom margin settings to your desired settings.

* Click OK.

* The new settings now appear as a code in the Styles Editor dialog window.
e Click OK.

* Click Closeinthe Style List dialog.

Y our style changes take immediate effect on the entire section.

Editing in MICROSOFT" Word 6/7/95 and Word 97/2000

The Word 6/7/95 and Word 97 sections are in an automatically numbered outline format that
allows you to easily insert and remove text. Word will automatically renumber the
remaining or inserted paragraphs. The outline numbering is not affected by any text that is
not part of the outline such as editor’s notes, tables, etc.

Supporting Documents

If you are using MASTERSPEC Basic or Short Form sections, or MASTERSPEC Interior
Design sections, you should review the help, reference, and tutorial information in the
supporting document for each section. The supporting documents are available in word
processor format on the MASTERSPEC CD-ROM, and on-line using a browser if you are
using MASTERWORKS.

MASTERSPEC Paragraph-Numbered Sections

Paragraph-numbered sections contain the following text elements:
* Header

» Footer

» Editor's Notes

» Section Title

* ThreeParts:. GENERAL, PRODUCTS, and EXECUTION (Except in SLV and
OUTLINE sections)

* ArticleTitles

» Paragraphs and subparagraphs (5 possible levels of subordination)
» Tables

» Data Sheets

« END OF SECTION Title

Introduction to Styles

Sections created for use with Microsoft Word are formatted using styles. Styles are a set of
formats that you can easily apply to text. For each paragraph in a Word document, thereisa
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predefined style that includes |eft and right margins, tab settings, paragraph numbering, etc.
Styles are used in Word for Windows sections for three reasons.

First, styles provide consistent and accurate formatting of the paragraph indenting and text
wrapping used in the paragraph-numbering system. Second, styles ensure that paragraphs
renumber correctly when sections are edited. Third, styles allow you to specify and quickly
change the formatting characteristics for paragraphs with the same style. To change the
format of paragraphs, simply change the format definition in the style; al the paragraphs
with that style will automatically reformat to reflect the change.

Styles Used in Microsoft Word

The styles used in Word sections are hierarchical. Each styleis based on one of the other
styles. Every style originates from the Normal style. The Normal styleisthe only style that
contains any font information. If you want to reformat the entire section in another font,
change the font in the Normal style.

Removing Text

To delete text from the section, select the text to be deleted and press the Delete key. Word
will automatically renumber the section.

Inserting Text by Changing the Paragraph Style

One way to insert paragraphs and subparagraphsin the Word outline format is to place the
cursor where you want to insert anew paragraph, then press the Enter key. Thiswill insert a
blank paragraph for your new text. To change the paragraph to the appropriate subordinate
level, place the cursor in the text, select anew style, and Word will automatically renumber
the text.

Styles contain formatting information that you can apply to paragraphs and subparagraphs.
The advantage of using styles instead of manually applying formatsis that you can easily
change your entire section’ s appearance by changing the formatsin a particular style.

To change a style for a paragraph:

» Select the paragraph (or text string, such as aunit of measure) where the style will be
applied.

* Click the Style drop-down list box on the formatting toolbar.

» Select astyle by double-clicking the style or highlighting the style, then press Enter.

MASTERSPEC sections have eight levels of automatic paragraph numbering. In Word
6/7/95, each one is preceded by a Heading # and a unique style name from the table below.

Style Name Description

PRT =Level 1 A paragraph in hidden text that
corresponds to the Part titles.

ART =Level 2 The style used for the Article titles.

DST =Leve 3 An outline level used only in sections
that contain Data Sheets and is used for
the Data Sheet title.
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PR1=Leve 4 Paragraph level 1 follows Articletitles
and Data Sheet titles. Number styleis
an uppercase letter. Example: A.
PR2=Level 5 Subparagraph level 2 follows a
paragraph level 1 and isanumber
followed by a period. Example: 1.
PR3 =Level 6 Subparagraph level 3 follows a
Subparagraph level 2 andisa
lowercase |etter followed by a period.
Example: a.

PR4=Level 7 Subparagraph level 4 follows a
subparagraph level 3 and is a number
followed by a parenthesis. Example:
1)

PR5=Level 8 Subparagraph level 5follows a
subparagraph level 4 and isalower
case |etter followed by a parenthesis
Example: a)

Editing MASTERSPEC Sections

When you delete or add paragraphs, the paragraph numbering is automatically changed.
The sections have been set up to recognize the style of the line before your insertion, and
automatically apply that styleto your added text. To change a style that has been
automatically applied, put the cursor at the beginning of the line, select Styles on your
toolbar, and assign the appropriate style. For additional help, refer to the instructions bel ow
for each style type. Paragraphs that follow your insertion are automatically renumbered.

Asyou scroll through a section, the cursor skips over the blank lines, allowing you to
quickly move through the section. The blank lines have been incorporated into the style so
spacing throughout the section remains uniform. To remove unwanted blank lines, highlight
aparagraph. You will notice that the blank lineis also highlighted. Choose For mat,
Paragraph, | ndents and Spacing, and adjust Befor e or After to set the number of spacing
points desired

Oneline equals 12 points. To remove aline, adjust the spacing up or down 12 points. The
spacing is set by selecting Format, Paragraph, | ndents and Spacing.

Text Insertion Instructions

When you create a new section or insert text in a section, you must pay attention to styles,
paragraphs, and other text elements so the section retains its integrity.

Hint: Itiseasier to edit sectionsif the Style Area on the left side of the screen is open, so
you can see the paragraph styles for each paragraph. To open the Style Area, choose
NORMAL fromthe VIEW menu. The Style Area option only exists in the normal view
mode. Choose Options fromthe Tools menu. Click the VIEW FOLDER tab if the folder is
not visible and enter .03" inthe STYLE AREA WIDTH box. Click OK. There should be a
vertical window on the left side of the screen displaying the paragraph styles.
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The following instructions help you insert text elements into an existing section using styles.
To easily create new sections, use an existing paragraph-numbered section and the attached
outline sample.

Microsoft Word automatically inserts a paragraph style based on the preceding paragraph.
To change this style, use the styles drop-down menu to apply the style you want as described
above.

Inserting Text in MASTERSPEC Styles

PART 1 - Title (Style PRT) — Part 2 and 3 also used. No Partsused in SLV and OUTLINE.

Usualy, you would not change the Part titles, because they conform to standard
specification section formats. If you need to reenter a Part title, do the following:

. Position the cursor with the arrow keys or mouse at the end of the paragraph where
you want to insert the new Part title.

. Press Enter to create a new paragraph.

. Choose Style from the For mat menu.

. Choose PRT from thelist of stylesand click OK.

. Type PART and press the Space Bar.

. Press the Space Bar again.

. Press (— ) to insert a hyphen, then press the Space Bar again.

. Type the Part title (GENERAL, PRODUCTS, or EXECUTION).
Article Title (Style ART)

. Position the cursor with the arrow keys or mouse at the end of the paragraph where
you want to insert the new Articlettitle.

. Press Enter to create anew blank paragraph.
. Choose Style from the For mat menu.
. Choose ART from thelist of stylesand click OK.

. Typethe Articletitle.
Paragraph at Indentation Level 1 (Style PR1)

. Position the cursor with the arrow keys or mouse at the end of the paragraph where
you want to insert the new paragraph.

. Press Enter to create a new paragraph.

. Choose Style from the For mat menu.

. Choose PR1 (paragraph) from the list of styles and click OK.
. Type the paragraph text.
Subparagraph at Indentation Level 2 (Style PR2)
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. Position the cursor with the arrow keys or mouse at the end of the paragraph where
you want to insert the new paragraph.

. Press Enter to create a new blank paragraph.

. Choose Style from the For mat menu.

. Choose PR2 (paragraph) from thelist of stylesand click OK.
. Type the paragraph text.

Subparagraph at Indentation Level 3 (Style PR3)

. Position the cursor with the arrow keys or mouse at the end of the paragraph where
you want to insert the new paragraph.

. Press Enter to create a new blank paragraph.

. Choose Style from the For mat menu.

. Choose PR3 (paragraph) from the list of styles and click OK.
. Type the paragraph text.

Subparagraph at Indentation Level 4 (Style PR4)

. Position the cursor with the arrow keys or mouse at the end of the paragraph where
you want to insert the new paragraph.

. Press Enter to create a new blank paragraph.

. Choose Style from the For mat menu.

. Choose PR4 (paragraph) from the list of styles and click OK.
. Type the paragraph text.
Subparagraph at Indentation Level 5 (Style PR5)

. Position the cursor with the arrow keys or mouse at the end of the paragraph where
you want to insert the new paragraph.

. Press Enter to create a new paragraph.

. Choose Style from the For mat menu.

. Choose PR5 (paragraph) from the list of stylesand click OK.
. Type the paragraph text.

The organization of a specification section is shown in the sample paragraph-numbered
section at the end of this chapter.

Microsoft Word 6/7/95 Outline Format

The outline format in Word provides a hierarchical format to a section. The headingsin the
outline help you organize and rearrange the section text. By displaying only the headings,
you can quickly move to a specific part of the section. Y ou can use outline headings to
rearrange the section’ s text and quickly execute formatting tasks. Word’'s Qutline View
displays the levels of headings and the text that belongs to each level.
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Inserting Text in Microsoft Word 6/7/95 Outline View

When you switch to Qutline View, theruler is removed and the Outline toolbar appears.
Thetext in your section is arranged in an outline format. Some paragraphs are headings and
one of the eight heading styles has been applied.

Select View | Qutline, or choose Outline on the View button. Move the cursor where you
want to insert text and press Enter. Thiswill give you a new blank number paragraph in
which you can add text. Y ou can promote or demote this paragraph using the appropriate
arrow buttons or equivalent keystrokes.

. To increase the heading by one level, click the promote button in the toolbar or press
Alt+ Shift+the plus (+) key.

. To decrease the heading by one level, click the demote button in the toolbar or press
Alt+ Shift+ the minus (-) key.
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SECTION 99999 - SAMPLE PARAGRAPH-NUMBERED SECTION

PART 1- GENERAL (Paragraph Syle PRT) — Not used in OUTLINE sections.

11 ARTICLE TITLE (Paragraph Style ART)
A. Paragraph (Paragraph Style PR1)
1. Subparagraph (Paragraph Style PR2)

a Subparagraph (Paragraph Style PR3)
b. Subparagraph (Paragraph Style PR3)

1) Subparagraph (Paragraph Style PR4)
a) Subparagraph (Paragraph Style PR5)
2. Subparagraph (Paragraph Style PR2)
3. Subparagraph (Paragraph Style PR2)

PART 2- PRODUCTS (Paragraph Style PRT) — Not used in OUTLINE sections.

2.1 ARTICLE TITLE (Paragraph Style ART)
A. Paragraph (Paragraph Style PR1)
1. Subparagraph (Paragraph Style PR2)
a Subparagraph (Paragraph Style PR3)

2. Subparagraph (Paragraph Style PR2)

PART 3 - EXECUTION (Paragraph Style PRT) — Not used in OUTLINE sections.

31 ARTICLE TITLE (Paragraph Style ART)
A. Paragraph (Paragraph Style PR1)

1. Subparagraph (Paragraph Style PR2)
2. Subparagraph (Paragraph Style PR2)
3. Subparagraph (Paragraph Style PR2)

B. Paragraph (Paragraph Style PR1)

END OF SECTION 99999
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Chapter 3
Preparing Project Specifications

Introduction

MASTERSPEC sections are organized according to CSI's three-part section format that
places subject matter in a uniform location in each section. CSl's SectionFormat defines the
three parts as follows:

Part 1 C Generd Administrative, procedural, and temporary requirements unique to the
section.

Part 2 C Products Materials, products, equipment, systems, and assemblies required for
inclusion in the project.

Part 3 C Execution  Preparatory actions and methods used to incorporate products into the
project. In some sections product schedules follow Part 3.

Information in each specification part is organized into articles, with subordinate paragraphs
and subparagraphs following each article. Articletitles are also organized according to
CSI/CSC's guidelines. MASTERSPEC uses an a phanumeric paragraph-numbering system
to designate parts, articles, paragraphs, and subparagraphs in a section. The paragraph-
numbering system uses alternating letters and numbers to indicate levels of subordination.

Y ou may change the numbering system to a decimal system, delete the paragraph-
numbering system, or add line numbering using MASTERWORKS. See the
MASTERWORKS User's Guide, Chapter 4 —"Multi File Features, Document Format Dialog,
Page Format Tab". MASTERWORKS can be used to change many default formats in
MASTERSPEC.

MASTERSPEC can be edited manually on paper, on-screen using aword processor, on-
screen using aword processor enhanced with MASTERWORKS, or on-screen using the
LINX Automated Editor. The following instructions apply to al types of editing. Refer to
Chapter 2 in this Guide for instructions on editing MASTERSPEC using your word
processor. The MASTERWORKS User's Guide has instructions on the use of
MASTERWORKS to enhance your word processor. Documentation for the LINX
Automated Editor software isincluded with the software and may be accessed on-line.
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Section Numbering and Naming Convention

MASTERSPEC sections follow CSI/CSC's PageFormat and SectionFormat. Each new and
updated section is numbered and titled according to CSI/CSC's 1995 Master Format. Each
number isfive digits, in one of sixteen divisions, e.g., 06402. In word processor versions, a
three-character suffix indicates the MASTERSPEC Library and Version, and thefile
extension indicates the word processor version, e.g. 06402fl _.doc. The MASTERSPEC
Consolidated Table of Contents lists by division, the section number, section title, alist of
libraries containing the section, the issue date, and a description of the section content.

Location of Specification Files on CD-ROM

MASTERSPEC section text files, supporting documents and MASTERWORKS software
are distributed on CD-ROM media. Section text files are in the indicated Mastspec\Word
and Mastspec\Wp folders for the following word processors:

Microsoft Word 2.0 Word2
Microsoft Word 6/7/95 Word6 7
Microsoft Word 97/2000 Word97
WordPerfect 5.1 Wp51
WordPerfect 6/7/8/9 Wp6 7 8

The supporting documents include the Cover, Evaluations, Drawing Coordination Checklist,
and Specification Coordination Checklist. They areinthe

\Specware\MWor ks\Windows\Setup.exe subfolder of the MASTERSPEC and
MASTERSPEC INTERIOR DESIGN CD-ROMs. The Specification Coordination Checklist
isnot in MASTERSPEC INTERIOR DESIGN.

Getting Started

If sufficient hard-disk space is available on a personal computer or anetwork file server,
create aMASTERSPEC master directory. All MASTERSPEC specification files should be
copied from the distribution CD-ROM to the master directory.

To start a project specification, select the sections you need from the appropriate
MASTERSPEC Library Table of Contents or from the Consolidated Table of Contents.
Hard copy versions of the tables of contents are included with each quarterly update.
Electronic versions are in the Mastspec\Wor d\Tocs or the Mastspec\Wp\Tocs subdirectory
on the MASTERSPEC CD-ROM. Create a project directory and copy the appropriate
section text files from the master directory to the project directory for editing. Do not edit
the specification files in the master directory unless they are to be used as office masters.

Project specifications can be created directly from MASTERSPEC section text, but you can
also prepare office masters with a pre-edit of MASTERSPEC sections. One method isto
edit each section for manufacturers and products and then add office standard or client
required language. Another method is to create several more narrower scope sections from
one MASTERSPEC section by deleting options. For example, one Licensed User created
the following office masters from SECTION 07511 B BUILT-UP ASPHALT ROOFING.

07511f11 Three or four ply with mineral cap over nailable deck.
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07511fI2 Three or four ply with mineral cap over non-nailable deck.
07511fI3 Three or four ply with mineral cap over insulation.
07511fl4 Three or four ply with aggregate over nailable deck.
07511fI5 Three or four ply with aggregate over non-nailable deck.
07511fl6 Three or four ply with aggregate over insulation.

These office masters may take lesstime to edit for each subsequent project, but must be
updated when the MASTERSPEC section is updated. There should never be aneed to
completely rewrite MASTERSPEC sections to create office masters.

Alternative Text

Sectionsinclude alternative and optional text (options) that you select to keep or delete for
each project. Alternative text includes articles, paragraphs, and subparagraphs. Keep
alternative text applicable to each project and delete text that is not applicable.

Optional Text (Options)

Options are words and phrases enclosed in square brackets ([ ]) and in boldface for easy
identification. In some cases, only one option from those shown should be selected. In
other cases, you may select one or more options. When deleting options, the text, bracket
pair and the boldface must be removed. When selecting an option to keep, the text remains,
but the bracket pair and boldface must be removed. MASTERWORKS software helps you
select options to keep or delete, remove bracket pairs and boldface text, delete options
entirely, and insert additional options. See MASTERWORKS User's Guide, Chapter 3,
"Single-File Features" for instructions on the automated selection of optional text.
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Editor's Notes

Editor's notes are included in section text where the selection or editing of alternative text is
required. In hard copy, they are in shaded boxes. In word processor files, they are in hidden
text, blue color, do not have paragraph numbers, start at the left margin, and end at the right
margin. Editor's notes are in hidden text and will not print unless hidden text is turned on.

Y ou can print sections with or without editor's notes, and select whether or not to display
them on-screen. Editor's notes should always be displayed when editing on-screen, and
should be printed on all hard copy for manual editing. Thiswill reduce the possibility that
editing instructions will be overlooked. Some Users del ete each editor's note that has been
addressed and leave applicable notes when a decision has not been made.

Editor's notes provide instructions to help you retain, delete, revise, or replace text, and
typically include the following information:

. Mandatory choice of alternative paragraphs

. Optional choices that can be left to the Contractor

. Refer to editing instructions or additional criteriain the Evaluations

. Coordination required with other choices located el sewhere in the section
. Criteriato be used in making choices

. Consideration for choices; such as cost, energy efficiency, etc.

. Required additional text

Insert Notes (Notes)

MASTERSPEC section text includes insert notes (notes) that are phrases enclosed in angle
brackets (< >) and in boldface for easy identification. The phrases prompt you to fill in the
appropriate information and may offer an example. In some cases, notes are included after
options and prompt you to add a custom requirement to the listed requirements. For each
project, notes can be replaced with appropriate text, deleted if inappropriate, or kept for |later
editing. Notes can be edited or custom notes added when you are creating office masters.
See the MASTERWORKS User's Guide, Chapter 3, "Single-File Features®, for instructions
on how to replace notes with text, remove bracket pairs and boldface, delete notes, and
insert additional notes.
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Project Notes

MASTERSPEC section text does not include project notes, but does include a project notes
style. Thisstyle letsyou insert project-specific notes and comments, to you, any member of
the design team or the Owner. Project notes are the equivalent of yellow self-stick notes.

Project Notes are in hidden text and may be converted to editor's notes by changing the style
to CMT or by selecting the "Keep" option in MASTERWORKS Single-File features.

Units of Measure

Section text includes both inch-pound (IP) and SI (metric) units. Y ou may select either unit
or both units. No editing isrequired if both units remain unless you want to change the
appearance order with the help of MASTERWORKS. When selecting IP units with
MASTERWORKS, the program deletes the IP and SI enclosing style codes, the S
parentheses, and Sl text, leaving only the IP units. If you select Sl units, MASTERWORKS
deletesthe IP and Sl enclosing style codes, the IP text, and the parentheses around the Sl
unit, leaving only the Sl text. See MASTERWORKS User's Guide, Chapter 3, "Single-File
Features, Units of Measure", for instructions on the automated selection of units of measure.

Editing MASTERSPEC

MASTERSPEC is acomprehensive commercial master specification system. Requirements
are included in the section text for arange of materials, products, and applications.
MASTERSPEC aways provides more information than is needed for a specific project. As
aresult, you must do the following as a minimum edit:

. Delete section text that is overly stringent, is redundant with another section, or does
not apply to the project.
. Add requirements and special options unique to the project. Edit the manufacturers

and products list. Add local and regional manufacturers and products.

MASTERSPEC section text includes full paragraphs and subparagraphs as alternative text.
Y ou often select appropriate aternative paragraphs without the need for any editing.

Only one of several aternative paragraphsis usually retained, unless more than one type of
product or material is required, or unless the selection isleft to the Contractor.

If more than one product or material is retained, each one must be uniquely identified both
in the specifications and on the drawings. One method is to include designations as part of
the descriptive names in the specifications. These designations could be in the form of

a phanumeric designations, such asin "Metal Locker MLB1" and "Metal Locker MLB2," or
words and numbers, such as"Locker Type 1" and "Locker Type 2." The first method
requires only the alphanumeric designations on the drawings. The second method requires
both the name and designation on the drawings. If designations are not used, descriptive
names such as "Wardrobe Lockers" and "Corridor Lockers" must be used to distinguish
products and materials in the specifications and on the drawings.

Many MASTERSPEC sections have articles that contain requirements about only one type
of activity, product, or material. This organization makes editing easier by allowing you to
delete the article and all the subordinate text if it isnot applicable. Example Articletitlesare
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"Preconstruction Testing", "Source Quality Control", and "Field Quality Control." Where
the project work is minor, not critical, or not complex enough to justify these activities, the
articles and all their subordinate text can be deleted.

Leaving unnecessary or inapplicable MASTERSPEC text in the section can obscure the true
extent of the work, causing biddersto allow for unnecessary contingenciesin pricing the
project. You should diligently proceed to remove all unnecessary text. Do not assume that
quality control isincreased and professional liability is reduced by retaining requirements
that do not apply to the project.

Preparation for Editing

Before editing each MASTERSPEC section, you should become familiar with the section.
Scan the Cover, Evaluations, Section Text, Drawing Coordination Checklist, and
Specification Coordination Checklist. Review the section content, identify possibilities that
could be overlooked, and identify subjects requiring further investigation.

The Cover describes the content of the section text and related products and work. It
includes products that could be inserted into the section if required, similar work usually
specified elsewhere, and closely related work specified in other sections.

The Evaluations describe characteristics and criteria for specifying the products and
materialsincluded in the section. They include an overview of products that might
otherwise be difficult to extract from manufacturers literature. The Evaluationsinclude the
following:

» Editing instructions, which are also referenced in editor's notes in the section text
. Scope of the section

. Description of product characteristics

. Specia design and detailing considerations, if applicable

. Referenced standards and suggested reference materials
. List of manufacturers
. Tables of products and manufacturers (not in all Evaluations)

At the beginning of many Evaluations, one or more editing instructions are included that
generdly relate directly to specific parts of the section text. An editor's note in the section
text refers back to the applicable editing instruction number in the Evaluations. The editing
instructions provide more extensive and detailed instructions than is possible with editor's
notes. Y ou should always scan these instructions and the remainder of the Evaluations
before editing the section text.

The editing instruction that typically occurs in a section where manufacturers and products
are named is areminder that these national manufacturers and products are only examples
and are not recommended or endorsed by the AIA or ARCOM.

Drawing Coordination Checklists contain organized drawing requirements that relate to the
section content. They indicate items not in the section text that should be on the drawings.
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Specification Coordination Checklists contain alist of other sections and requirements that
relate to the section content. They provide alocation to indicate items to be furnished by the
Owner; how to apply allowances, unit prices, and alternates to the section, if applicable; and
other sections that may have requirements applicable to the section.

Editing Sequence

The first step with MASTERSPEC sections that contain manufacturers and productsisto
edit the manufacturers, products, and materialsin Part 2. Y ou should retain products and
materials applicable to the project and delete those that are not. If necessary, add local and
regional manufacturers and products. Thisfirst step is the basis for the edit of installation
requirements in Part 3 and general requirementsin Part 1.

Note: Some sections, for example, those in Division 15 with mechanical piping, the first
step isto edit the applications portion in Part 3. Thisis because the application
paragraphs describe the components of the system specified in Part 2.

The second step isto edit Part 3. Y ou should select and coordinate the installation
requirements that relate to products and materialsin Part 2.

Thethird stepisto edit Part 1. Y ou should coordinate the requirements of Part 1 with the
products and materials specified in Parts 2 and 3. This includes editing the "Summary"
Article to reflect the content of the section.

Note: Itemsin Part 1 can add cost to the project while not necessarily adding quality.
Requirements such as mockups or restrictive installer qualifications may be unnecessary for
smaller or less-complex projects.

The "Related Sections' paragraph in Part 1 should also be edited. It should only list
products, construction, and equipment that the Contractor might expect to find in this section
but are specified elsewhere. Other sections may contain requirements that need to be
coordinated with the section being edited. These sections should not be listed in the
"Related Sections’ Paragraph, because no one would expect to find the requirements from
these sections in the section being edited.

If required by the Owner, a"Reference Standards Article" can be added to Part 1 with
standards copied from the Evaluations. If standards are added, you should aways verify the
designation, title, and date of the standard because an update of the standard may have
occurred since the section was last issued. If amore current standard date is used, you
should review the standard and the section text to determine if any changes are required.

Manufacturers and Products

MASTERSPEC includes manufacturers names and products in Part 2 of the section text.
Only manufacturers with products that are distributed nationally are included. Regional and
local manufacturers that meet specified requirements can be added to or replace names on
thelist.

Y ou should verify that the standard products of each selected manufacturer comply with the
specified performance and descriptive requirements. The section text should state if custom
unitsarerequired. When editing product requirements, do not restrict or add proprietary
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features that only one manufacturer can meet, unless you really intend to limit selection to
products from that manufacturer.

Manufacturer and product lists are preceded by standard MASTERSPEC paragraphs, as
follows:

The following "nonproprietary" paragraphs indicate that the Contractor may select any
manufacturers or products on the following list, or any other manufacturers or products that
meet the specified requirements. With either paragraph, manufacturers or products other
than those listed

are not required to be submitted as substitutions, but they must be shown to comply with
requirements by following the submittal procedures for comparable products.

» "Avallable Manufacturers. Subject to compliance with requirements,
manufacturers offering products that may be incorporated into the Work include,
but are not limited to, the following:"

» "Avallable Manufacturers. Subject to compliance with requirements,
manufacturers offering products that may be incorporated into the Work include,
but are not limited to, the manufacturers specified in other Part 2 articles of this
Section.”

» "Available Products: Subject to compliance with requirements, products that
may be incorporated into the Work include, but are not limited to, the following:"

» "Avallable Products: Subject to compliance with requirements, products that
may be incorporated into the Work include, but are not limited to, those specified
in other Part 2 articles of this Section."

The following "semiproprietary” paragraphs require the Contractor to select only
manufacturers or products named in the section text, either in alist following these
paragraphs or elsewhere in the section text, that could be in another article in Part 2. With
either paragraph, manufacturers and products, other than those listed, must be submitted as
substitutions and must comply with requirements. Division 1 Section 01600 - PRODUCT
REQUIREMENTS establishes the default requirements for whether or not substitutions will
be considered.

"Manufacturers. Subject to compliance with requirements, provide products by
one of the following:"

* "Manufacturers: Subject to compliance with requirements, provide products by
one of the manufacturersindicated in other Part 2 articles of this Section.”

*  "Products: Subject to compliance with requirements, provide one of the
following:"

* "Products. Subject to compliance with requirements, provide one of the products
indicated in other Part 2 articles of this Section.”

These alternative paragraphs give you the following options:

» With paragraphstitled "Available Manufacturers,” list available manufacturers
known to you

» With paragraphstitled "Available Products," list available products known to you
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With paragraphs titled "Manufacturers,” list only those manufacturers that have
products that are specifically selected or allowed for the project

With paragraphs titled "Products,” list only those products specifically selected
or allowed for the project

If you do not want to list any manufacturers or products, del ete paragraphs and
names of manufacturers and products. Thiswill result in anonproprietary,
nonrestrictive specification in which reliance is placed entirely on using
descriptive, performance, reference standard, or a combination of methods to
establish salient features of products.

Thefollowing "basis of design" paragraphs indicate that the design is based on the product
named and the Contractor may select that product or another product of a manufacturer
listed. Products of other manufacturers must be shown to comply with requirements by
following the submittal procedures for comparable products. Products of manufacturers
other than those listed are required to be submitted as substitutions.

"Basis-of-Design Product: The design for [product] named in [Part 2" <insert
title>" Article] isbased on [product name and manufacturer]. Subject to
compliance with requirements, provide the named product or a comparable
product by one of the other manufacturers listed."

"Basis-of-Design Product: The design for [product] is based on <insert
product name and manufacturer>. Subject to compliance with requirements,
provide the named product or a comparable product by one of the following:"

"Basis-of-Design Product: The design for [product] is based on <insert
product name and manufacturer>. Subject to compliance with requirements,
provide the named product or a comparable product by one of the other
manufacturersin other Part 2 articles of this Section.”

These dternative Basis-of-Design Product paragraphs give you the following option:

List one product known to you to establish the significant qualities related to
type, function, dimension, in-service performance, physical properties,
appearance, and other

characteristics for purposes of evaluating comparable products of other named
manufacturers.

List only those manufacturers specifically selected or alowed for the project
from which comparable products may be accepted.
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Method of Specifying Examples

The Evaluationsin SECTION 01600 B PRODUCT REQUIREMENTS describe the methods
of specifying used in MASTERSPEC and provide a comparison to those defined in CSl's
Manual of Practice. A tableisincluded that compares the wording in Division 1 and
individual Sections of MASTERSPEC and CSI specifying methods. Examples of Part 2 text
with fictitious product and manufacturer names are shown below to demonstrate alternatives
when you specify products and manufacturers. MASTERSPEC can be edited to produce
any of the specifying methods for manufacturers and products.

Available Products/Available Manufacturers (Nonproprietary)

The following example is from a nonproprietary specification where specific products are
named in the same article where other product requirements are also specified. It
demonstrates the use of alphanumeric designations to distinguish between two or more
different products of the same type. These alphanumeric designations should be used on the
drawings to indicate where each of the productsis located.

21 RESILIENT ATHLETIC FLOOR TILE, AFT-1

A. Available Products: Subject to compliance with requirements, products that may be incorporated into
the Work include, but are not limited to, the following:

1. Sport Floor; Floor Co.
2. Game Court; Rubber Inc.
3. Game Tile; Sports Floors, Inc.

w

Material: Rubber.

Style: Solid surface.

o 0

Installation Method: Adhesive.

Traffic-Surface Texture: Smooth.

m

F. Size: 36 inches square.
G.  Thickness: 1/4inch.
H. Weight: Not lessthan 10 Ib per tile.

l. Color and Pattern: As selected by Architect from manufacturer's full range.

Products/Manufacturers (Semiproprietary)

This example is from a semiproprietary specification in which specific products are named.
It al'so demonstrates the use of a phanumeric designations to distinguish between two
different products of the same type.

21 RESILIENT ATHLETIC FLOOR TILE, AFT- 2

A. Products. Subject to compliance with requirements, provide one of the following:
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1 Grid Tile; Plastic Grids, Inc.
2. Pool Deck; Sports Floors, Inc.

B. Thickness: 1/2 inch.

C. Color: Asselected by Architect from manufacturer's full range.

Product/Manufacturer (Proprietary)

Thisexample isfrom a proprietary specification with only one product and manufacturer
listed. Because only one type of product is required, an al phanumeric designation is not
included in the Article title; however, such designation could be inserted to identify the
location of this product on the drawings.

2.1 SHEET VINYL ATHLETIC FLOORING
A.  Product: Provide the following:

1.  Court Floor, Beige; Basketball Floor Co.

Descriptive (Nonproprietary)

This example is from a nonproprietary, descriptive specification where products are not
named. Because only one product of thistype is required, an alphanumeric designation is
not included in the Article title; however, such a designation could be inserted to identify the
location of this product on the drawings.
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2.1 RUBBER-STRIPTILE

A.

Materials and Construction: Close-nap, carpetlike tiles of rubber-fabric strips, made
from recycled tires, bonded to a dry-adhesive backing that acts as a catal yst with
installation adhesive to form tile-to-substrate bond.

Size: 12 inches sgquare.

Thickness: 3/8 inch.

Color and Pattern: As selected by Architect from manufacturer's full range.

Fire-Test-Response Characteristics: Passing 16 CFR 1630 (DOC FB1B70).

Basis of Design (Semiproprietary)

The following example is from a semiproprietary specification where the method of
specifying is naming one product as the basis of design.

21

A.

MANUFACTURERS

Basis-of-Design Product: The basis of design for toilet and bath accessories are the products named
in Part 2 "Toilet and Bath Accessories’ article. Provide either the named product or a comparable
product by one of the following:

1. Toilet and Bath Accessories:

A & JWashroom Accessories, Inc.

American Specialties, Inc.

Bobrick Washroom Equipment, Inc.

Bradley Corporation.

General Accessory Manufacturing Co. (GAMCO).
McKinney/Parker Washroom Accessories Corp.
<lnsert manufacturer.>

@ rPoo oW
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23 TOILET AND BATH ACCESSORIES
A.  Paper Towel Dispenser <Insert drawing designation, e.g., TBA-1>:

Basis-of-Design Product: <Insert manufacturer and product.>
Mounting: [Recessed] [Surface].

<lInsert towel types and capacities.>

Material: Stainless steel.

Lockset: Tumbler type.

Refill Indicators: Pierced dots at sides or front.

ok wWNE

Product Schedules

Some MASTERSPEC sections include a product schedule at the end of Part 3. The
schedule is an aternative method of specifying two or more products of the same type and
form, but differ in one or more respects. If the project requires a 4-inch-high rubber topset
base and a 6-inch-high rubber cove base, a schedule can be used to describe the
requirements for each base.

In the schedule, include separate lists for each type of product required with manufacturers
and product names and a description of the construction and features of each. After editing
the schedule, you must coordinate product features with all requirements specified in Part 2.
MASTERSPEC sections that include a product schedule in the section text also include an
example schedule in the Evaluations for reference.

When using product schedules, you should retain one of the following paragraphsin the
"Manufacturers' Article that refersto product schedules:

The following "nonproprietary” paragraphs are for use in Part 2 when product schedules are
specified at the end of Part 3. They indicate that the Contractor may select any manufacturer
or product on the list or any other manufacturer or product that meets the specified
requirements. With either paragraph, manufacturers or products other than those listed are
not required to be submitted as substitutions, but they must be shown to comply with
requirements by following the submittal procedures for comparable products.

"Available Manufacturers: Subject to compliance with requirements, manufacturers
offering products that may be incorporated into the Work include, but are not limited
to, the manufacturers indicated in the [Product] Schedule at the end of Part 3."

"Available Products: Subject to compliance with requirements, products that may be
incorporated into the Work include, but are not limited to, the products indicated in
the [Product] Schedule at the end of Part 3."

The following "semiproprietary” paragraphs are for use in Part 2 when product schedules are
specified at the end of Part 3. They require the Contractor to select only manufacturers or
products on the list. With either paragraph, manufacturers or products other than those
listed must be shown to comply with requirements. Section 01600 - PRODUCT
REQUIREMENTS establishes the default requirement whether or not substitutions will be
considered.
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* "Manufacturers. Subject to compliance with requirements, provide products by
one of the manufacturers indicated for each designation in the [Product]
Schedule at the end of Part 3."

* "Products: Subject to compliance with requirements, provide one of the products
indicated for each designation in the [Product] Schedule at the end of Part 3."

The following "basis of design” paragraph is for use in Part 2 when product schedules are
specified at the end of Part 3. It indicates that the design is based on the product named and
the Contractor must select that product or another product of a manufacturer listed. Products
of other manufacturers must be shown to comply with requirements by following the
submittal procedures for comparable products. Products of manufacturers other than those
listed are required to be submitted as substitutions.

"Basis-of-Design Product: The design for [product] named in [Part 3" <insert title>"
Schedul€] isbased on [product name and manufacturer]. Subject to compliance with
requirements, provide the named product or a comparable product by one of the other
manufacturers listed."

Sample Door Hardware Schedule

The following is an example of acompleted schedule that you may consider adapting to
specify door hardware set requirements. The example contains the kind of data that would
be inserted and the order in which it should be listed, as recommended by DHI. Y ou must
insert appropriate product requirements in the Door Hardware Schedule for each door
hardware set required for the Project.

This example names actual manufacturers' products, using model numbers. Manufacturers
are identified by abbreviations.

Products of randomly selected manufacturers are included in the sample to demonstrate how
to specify names of products and manufacturers and not to indicate products equivalent in
appearance and performance. Products and manufacturers named are neither recommended
nor endorsed by the American Institute of Architects or ARCOM.
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DOWNTOWN PROJECT #10

3.8 DOOR HARDWARE SCHEDULE (Example - Naming Manufacturers Products)

Hardware Set No. 1

3 Hinges TB2714

1 Lockset 8205 LNL

1 Closer 4011 — Regular - Alum

1 Kick Pate #48 - 10 x 2inchesL.D.W.(254 x 51 mm L.D.W.)
1 Wwal Stop 407

1  Set Smoke Seal 5050

Hardware Set No. 2

1 Electric Hinge T4B3386 MM x NRP

1 Electric Hinge T4B3386 CC x NRP

1 Hinge T4B3386 x NRP

1 Electrified Panic Exit Device EQ0075L x FSE x 9992L - M

1 Cylinder 320200

1 Closer 4110 Cush Alum

1 Kick Plate #48 - 10 x 2 inchesL.D.W.
(254 x 51 mm L.D.W.)

1 Threshold R50SA x Miter

1 Weather Stripping 303AV Head and Jamb

1 Sweep 307AV

1  Access Control 7183 x 7804 Box

1 Reay 7000 (JB7)

1 Heater 7801

1  Set Communication Cable 7865, 7866, 7868

1 Power Supply MPB-851

MCK
SGT
LCN
NTQ
VS
NGP

MCK
MCK
MCK
VD
MED
LCN

NTQ
PEM
PEM
PEM
VD
VD
VD
VD
VD

2/98

626
626
689
630
626

626
626
626
626
626
689

630
627
627
627

Access control shall release electrified panic exit device outside trim and shall shunt monitoring

hinge. Monitor door position at security panel.

END OF SECTION 08711

DOOR HARDWARE

08711 - 37

Page 3-15 - Preparing Project Specifications




Environmental Considerations

Recent MASTERSPEC sections include environmental considerations in the Evaluations.
The following three paragraphs are from SECTION 09622 B RESILIENT ATHLETIC
FLOORING. Similar environmenta information is included where appropriate in new and
updated sections. The information is not exhaustive and you may need to consider other
environmental issues as required by individual owners and local regulations.

Recycled rubber and vinyl are used to produce smooth and nondirectional textured
tiles. Of the manufacturers listed at the end of these Evaluations, only American
Floor Products currently advertises the use of recycled rubber and vinyl for solid-
surfacetiles. For use under its sheet vinyl, Advantage advertises an optional pad that
incorporates recycled rubber. Contact manufacturers to verify the extent of recycled
materials used in products and whether materials are recycled postconsumer waste or
manufacturing waste.

Recycled truck and bustires are used to produce rubber-strip tile. Thesetiles have
aclose-nap, carpetlike surface made from rubber-fabric strips bonded to aflexible
dry-adhesive backing. The backing reacts with separate adhesives applied to the
substrate to form the tile-to-substrate bond.

VOC restrictions of authorities having jurisdiction may affect the selection of
installation adhesives for adhered flooring. The Section Text places responsibility
on the flooring manufacturers for selecting appropriate adhesives for substrates and
conditions indicated. If specific adhesive requirements or VOC restrictions are
inserted in the Section Text, verify requirements of authorities having jurisdiction. If
odor and indoor-air quality during installation and curing are concerns, consult
manufacturers for recommendations.

Coordinating Drawings with Specifications

Producing good construction documents requires an intensive coordination effort involving
both Drawings and Specifications. Because master guide specifications exist before
Drawings are prepared for each specific project, they must be general and broad in scope.
All checklist items may not apply to every project. With proper planning and
communication, the production team can begin producing Drawings with an awareness of
specification content. MASTERSPEC Drawing Coordination Checklists offer the principal
means for simplifying and organizing the coordination process, but Editor's Notes within the
Section Text and in the Evaluations also often include instructions about what should be
indicated on the Drawings.

Complementary functions are served by the Drawings and Specifications. Understanding
which kind of information each should contain and how they should interrelate is essential.
The following genera rules are recommended for location of information on Drawings and
in Specifications:

l. Drawings should contain information that is more clearly shown graphically. Thisincludes

the following:
A. Locations.
B. Number of units.
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C. Size. Exceptionsinclude dimensions of manufactured products that are used
repetitively -- these are better described in the Specifications.

D. Shape or configuration.
Interrelationshi ps between components and systems.

F. Names of products coordinated with the names used in the Specifications to identify
products generically as opposed to using of proprietary product names. Aslittle
gualitative information as possible should be conveyed by names -- let the
Specifications handle that.

. Specifications should contain information more easily presented in words Thisincludes the
following:

A. Quality required.
B. Procedures to be used.

C. Definitions of terms.

Tables and schedules may be located either on the Drawings or in the Specifications. The
choiceisusually related to the table or schedule size, but it is also useful to consider what is
traditional practice, .e., here the contractor will expect to find them. MASTERSPEC avoids
using words "as shown on the Drawings" to enable this flexibility, but does use "as
indicated" if the information may be either on the Drawings or in separate schedules.

Although the AIA General Conditions of the Contract for Construction state that the
Drawings and Specifications are complementary, i.e., they have equal weight, bidders often
overlook products that are not at least mentioned on the Drawings. Building officials often
require certain information to be placed on the Drawings despite the fact that it is better
specified than drawn.

Frequently Asked Questions

. What isincluded with MASTERSPEC?

A CD-ROM containing the MASTERSPEC specification sections and
MASTERWORKS software for your word processor, The MASTERSPEC User's
Guide, and the MASTERWORKS User's Guide. Reference binders with hard copy
versions of the MASTERSPEC specifications, including all supporting documents,
may be ordered separately.

. Are the specification sections ready for use on any project?

MASTERSPEC specifications are master specifications. Each section must be
edited to be specific for each project. Selections must be made from alternative and
optional text and additional project-specific text must be added. Selection of
manufacturers and products must be made and additional manufacturers inserted,
where applicable.

. What computer skills are required to use MASTERSPEC?

A working knowledge of Microsoft Windows 3.x, 9x, NT 4.0 or Windows 2000
including File Manager or Windows Explorer. Y ou should know how to create
folders, copy files, and delete files. Y ou must be familiar with one of the supported
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word processors, including editing tools and automatic paragraph-numbering
methods, especially multilevel paragraph numbering for Microsoft Word.

Do | need to install the specification sections on my computer?

A MASTERSPEC specification sections are provided in specific word processing
formats. Each section is ready to use with your word processor. We recommend that
you create a master directory on your computer hard-disk drive and copy all sections
to that directory. Y ou use the MASTERSPEC sections text to create project
specifications or office masters. For each project, create a project directory, then
copy sections from the master directory to the project directory for editing.

Are MASTERSPEC specifications available for all word processors?

MASTERSPEC specifications and MASTERWORKS software are available for the
most recent versions of Microsoft Word and, WordPerfect for Windows, and the
Macintosh. MASTERSPEC versions are available for older versions of Microsoft
Word and WordPerfect, but you will not have access to the additional capability of
MASTERWORKS.
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Chapter 4
MASTERSPEC’ OUTLINE Specifications

Introduction

OUTLINE Specifications are designed to help you produce complete, accurate, and
professional outline specifications with minimal time and effort. Each section of OUTLINE
is based on the Full Length and Short Form MASTERSPEC section of the same number and
title. OUTLINE isaconcise master guide specification set that directly correspondsin
content and terminology to requirements that are appropriate for outline specifications.
MASTERWORK S software is included for use with your word processor to simplify many
editing and formatting tasks. Y ou can produce specifications in several formats including
project manuals, sheet specifications, and drawing notes.

Full Length and Short Form MASTERSPEC libraries are available from ARCOM to help
you produce project specifications for construction projects of any size, complexity, or
duration. OUTLINE specification sections could be produced by significant editing of the
text in Full Length MASTERSPEC sections, but the effort would be time consuming.
OUTLINE Specifications provide an appropriate guide to produce project outline
specifications.

Appropriate Use

Outline specifications are typically produced during the design devel opment stage of a
project. They arerequired by AIA Document B141, the agreement between the Owner and
the Architect, along with drawings and other documents to "identify major materials and
systems and establish in genera their quality levels." Outline specifications are not for
bidding, negotiation, or construction.

CSl's Manual of Practice, Chapter FF/180, "Preliminary Project Descriptions and Outline
Specifications,” includes the following purposes for preparing an outline specification:

* Provide abasisto produce or revise cost estimates, time schedules, and value-
engineering studies.

* Record product decisions early in the documentation process, and provide a checklist for
the project team when selecting products and methods during development of the Project
Manual.

* Provide ameans of communication among members of the project design team and
between the team and the Owner.

» Help control the decision-making process and encourage clarity in the construction
documents.

* Reduce the potential for design changes at later stages and the consequent inefficient use
of design team time.

» Coordinate terminology in the construction documents.
* Assist ownersin understanding proposed materials and systems.
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OUTLINE helps you create project specifications that meet all of the above criteria.

Format, Section Numbering, and Naming Convention

OUTLINE sections are written in brief, concise statements. They are in paragraph-
numbered format and automatically renumber during editing. Sections follow CSl's
recommended outline specification format. They are not in three-part format and do not
include part titles. Each section is numbered and titled to match the corresponding Full
Length MASTERSPEC section. The date on the right side of the header is the issue date of
the OUTLINE aswell as the corresponding Full Length MASTERSPEC section.

Each OUTLINE A/S/C section follows the order and uses the same terminology as the
corresponding Full Length and Short Form MASTERSPEC section. This makes editing of
the final project specifications based on Full Length or Short Form MASTERSPEC much
easier. Thetable of contents lists the issue date, section number, and section title.
OUTLINE A/S/C sections include Divisions 1 through 14 with sections for architectural,
structural, and civil work, and selected sections from Divisions 15 and 16 for mechanical
and electrical work.

There are afew sections in Full Length and Short Form MASTERSPEC A/S/C that are not
in OUTLINE A/S/IC. Some A/S/C sections are Evaluations only and no section text is
available for inclusion in OUTLINE A/S/C. These Evaluations sections include the
following:

01000 — General Requirements

02455 - Driven Piles

07510 — Built-up Bituminous Roofing

07530 — Elastomeric Membrane Roofing

07550 — Modified Bituminous Membrane Roofing
08460 - Automatic Entrance Doors

08515 — Aluminum and Wood Windows

08631 — Translucent-Insulating-Panel Skylights
08710 - Door Hardware

09400 — Terrazzo

09910 — Painting

09920 — Interior Painting

10615 — Demountable Partitions

Each OUTLINE M/E section follows the order and uses the same terminology as the
corresponding Full Length and Short Form MASTERSPEC section. This makes editing of
the final project specifications based on Full Length and Short Form MASTERSPEC much
easier. Thetable of contents lists the issue date, section number, and section title.
OUTLINE M/E sections include Divisions 1, selected sections from Division 2, 3, 5, 6, 7, 8,
9, 10, 13 and Divisions 15 and 16.
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There are afew sections in Full Length and Short Form MASTERSPEC M/E that are not in
OUTLINE M/E. Some M/E sections are Evaluations only and no section text is available for
inclusionin OUTLINE M/E. These Evaluations sections include the following:

01000 — General Requirements

09910 — Painting

13920 — Fire Pumps

15510 — Heating Boilers and Accessories
15540 — Fuel-Fired Heaters

15560 — Fuel-Fired H&V Units

15830 — Fans

Location of Specification Files on CD-ROM

OUTLINE specifications for supported word processors and MASTERWORKS software
are available on CD-ROM. Specification sections are in the Outline\Word and Outline\Wp
foldersfor the following word processors:

Microsoft Word 6/7/95
Microsoft Word 97/2000
WordPerfect 6/7/8/9

Getting Started

If sufficient hard-disk space is available on your personal computer or network file server,
create an OUTLINE master directory. Copy al OUTLINE files from the distribution CD-
ROM to the OUTLINE master directory.

To start an outline project specification, select the appropriate sections from the table of
contents, create a project directory, and copy the selected files from the master directory to
the project directory for editing. Do not edit the specification files in the master directory
unless they are used as office masters. Edit only the filesin each project directory.
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Editing Assistance Features

Alter native and Optional Text (Options)

Sections include alternative text and optional text (options). Alternative text includes
articles, paragraphs, and subparagraphs. Y ou keep alternative text specific to each project.
Y ou delete all text not specific to each project.

Options include words and phrases enclosed in square brackets ([ ]) and in bold for easy
identification. In some cases, only one option from those shown should be selected. In
other cases, you may select one or more options. When deleting options, the bracket pair
and the bold text are removed. When selecting an option, the bracket pair and bold are
removed, leaving only the text. MASTERWORKS softwareisincluded to help you select
options, remove bracket pairs and bold text, delete options entirely, and insert additional
options. See Chapter 3 — Single File Features in the MASTERWORKS User's Guide, for
instructions on the automated selection of optional text.

Editor's Notes

Editor's notes are included where the selection or editing of alternative text isrequired. In
hard copy, they are in shaded boxes. In word processor files, they are in hidden text, in blue
color, do not have paragraph numbers, start at the left margin, and end at the right margin.
Since editor's notes are in hidden text, they will not print unless hidden text is turned on.
The appearance of editor's notes on-screen and in hard copy may be customized with
MASTERWORKS.

Insert Notes (Notes)

Sections include insert notes (notes), which are phrases enclosed in angle brackets (< >) and
in bold for easy identification. The phrases prompt you to fill in the appropriate information
and may offer an example. In some cases, notes are included after options to prompt you to
enter a custom requirement. For each project, notes are replaced with text, deleted, or kept
for later editing. MASTERWORKS Multi File Features help you replace notes with text,
remove bracket pairs and bold text, delete notes entirely, and insert additional notes.

Project Notes

A project notes styleisincluded in OUTLINE sections. This style lets you insert project
specific notes to any member of the design team. Project notes are the equivalent of yellow
self-stick notes. They are in hidden text and may be converted to editor's notes by selecting
the "Keep" option in MASTERWORKS Single File Features.

MASTERSPEC specification sections do not include project notes. With
MASTERWORKS you can add project specific notes, reminders, and comments to other
members of the design team.
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Unitsof Measure

Sections include both inch-pound (IP) and SI (metric) units. Y ou may select either unit or
both units. No editing isrequired if both units remain unless you want to change the
appearance order with the help of MASTERWORKS. When selecting IP units with
MASTERWORKS, the program deletes the IP and Sl enclosing style codes, the Sl
parentheses, and Sl text, leaving only the IP units. If you select SI units only,
MASTERWORKS deletes the IP and Sl enclosing style codes, the IP text, and the
parentheses around the Sl unit, leaving only the S text. See MASTERWORKS User's
Guide, "Multi File Features," for instructions on the automated selection of units of measure.

Recommended Editing Sequence

OUTLINE Specifications may be edited in any sequence. MASTERWORKS will help with
many editing, formatting, and production functions. A typical sequence may include the
following:

Select project sections and copy the files from the master directory to a project directory for
editing.
Use MASTERWORKS on each section in the project directory to:

. Review editor's notes.

. Select from alternative text and delete inapplicable article titles, paragraphs, and
subparagraphs.

Caution: If aparagraph is deleted that is followed by subparagraphs, the
subparagraphs can be incorrectly subordinate to the preceding paragraph. Those
"hanging" subparagraphs should also be del eted.

. Select optional text and delete inapplicable options.

*  Replaceinsert notes with text and insert other project specific text.

. Insert manufacturer names, product names, and descriptions where prompted by an
insert note, unless a nonproprietary specification is required.

. If aproprietary specification is needed, delete unnecessary descriptive requirements.

. Select units of measure.
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Use MASTERWORKS on al sectionsin the project directory to:

. Produce consistent headers and footers.
. Select section format.

. Print the sections.

. Produce and print the table of contents.

Project Specification Formats

Although OUTLINE sections follow the recommended CS| outline specification format, several options to
format the final documents and condense each section to the shortest appropriate form are provided.

MASTERWORKS helps you produce several final formats, including the following:

. Project Manual format (the default) includes the following:

Section number and title
Headers and footers

Part and Article titles
Paragraphs and subparagraphs
End of section titles

Triple spacing of section titles
Double spacing of article titles
and paragraphs

Single spacing of subparagraphs

Copyright 1998 AIA

SECTION 00000 - [SECTION TITLE]
Part 1 -GENERAL

11 ARTICLETITLE

A. Paragraph

Subparagraph

2. Subparagraph
B. Paragraph
12 ARTICLETITLE
A. Paragraph
END OF SECTION 00000

[SECTION TITLE] 00000 - 1
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See Chapter 4 - Multi
MASTERWORKS User's Guide, for information about automated formatting of alternative specification

formats.

Sheet Specification format

includes the following:

SECTION 00000 - [SECTION TITLE]

Section number and title 12 ARTICLETITLE
Articletitles
Paragraphs and subparagraphs A. Paragraph
Double spacing of section titles Subparagraph
Single spacing of articles,
titles, paragraphs, and B 2 P Subpalt‘agraph
subparagraphs ) aragrap

12 ARTICLETITLE

A. Paragraph

Drawing Notes format includes

the following:

SECTION 00000 - [SECTION TITLE]

Section number and title A. Paragraph
Paragraphs and subparagraphs Subparagraph
Single Spacing of paragraphs 2. Subparagraph
and subparagraphs. B. Paragraph

C. Paragraph

File Features in the
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Custom Office Masters

OUTLINE sections can be modified to satisfy personal preferences and office standards.
Office masters are produced by an edit that includes the selection, deletion, and addition of
alternative and optional text; deletion, replacement, and addition of insert notes; insertion of
office standard text, manufacturers, products, editor's notes, and project notes; and
modification of headers and footers.

If sufficient hard-disk spaceis available on asingle personal computer or on a network file
server, create an office master folder. All OUTLINE section files should be copied from the
distribution CD-ROM to the office master folder. Thesefiles are edited to create the office
master specifications. This office master folder would become the source of sections copied
to each project directory for editing.

MASTERWORKS also includes atemplate for producing new sections. When you open the
template, you are prompted for the section number and title. The section number and title
will be inserted in the default locations in the section. Then you delete inapplicable sample
text and insert your text under the appropriate part and article headings and insert other
articles to suit the subject of the section. Y ou may use MASTERWORKS to apply
consistent styles to your text so the new section is fully compatible with MASTERWORKS
and other OUTLINE sections.

Frequently Asked Questions

. What isincluded with OUTLINE?

OUTLINE includes this User's Guide, a printed copy of the OUTLINE specifications, a CD-ROM
containing the specification sections, MASTERWORKS software for your word processor, and the
MASTERWORKS User's Guide.

. Are the specification sections ready for use on any project?

OUTLINE specifications are master specifications. Each section must be edited to
be specific for each project. Selections must be made from alternative and optional
text. Names of manufacturers and products must be inserted where applicable.

. What computer skills are required to use OUTLINE?
A working knowledge of Microsoft Windows 3.x, 9.x, Me or NT 4.0, 2000 including File Manager or
Windows Explorer. You should know how to create folders, copy files, and delete files. Y ou must be
familiar with one of the supported word processors, including editing tools and automatic paragraph
numbering methods, especially multilevel paragraph numbering for Microsoft Word.

. Do | need to install the specification sections on my computer?
OUTLINE specification sections are provided in specific word processing formats. Each section is
ready to use with your word processor. We recommend that you create a master directory on your
computer hard-disk drive and copy al sections to that directory. For each project, create a project
directory, then copy sections from the master directory to the project directory for editing.

. Are OUTLINE specifications available for all word processors?
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OUTLINE specifications and MASTERWORKS software are available for current versions of
Microsoft Word for Windows and the Macintosh and WordPerfect for Windows. Although other
word processor versions may work with OUTLINE files, you would not have access to the additional
capability of MASTERWORKS,

Wheredo | start?

See the "Getting Started" section in this Chapter on page 3-2. Read the instructions for installing
MASTERWORKS for your word processor in Chapter 1 of the MASTERWORKS User's Guide. Start
your word processor, point and click on MASTERWORKS on the menu bar, and let OUTLINE and
MASTERWORKS go to work for you.
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Appendix
Contact Information

Technical Support

The OUTLINE and MASTERWORKS User's Guides and MASTERWORKS on-line help will answer
questions about capability and use of the software. Y ou may also contact the ARCOM staff by mail, e-mail,
telephone, or fax.

Offices
ARCOM ARCOM
The Aspen Building King Street Station
332 East 500 South Street 225 Reinekers Lane
Salt Lake City, UT 84111B3309 Alexandria, VA 22314B2875
Telephone: (801) 521B9162 Telephone: (703) 68489153

Softwar e and Technical Support by Telephone, Fax, or E-mail

Telephone: (800) 424B5080
Fax: (801) 521B9163
E-mail: support@arcomnet.com

Specification Writer and Information Specialist by Telephone, Fax, or E-mail

Telephone: (800) 200B6652
Fax: (703) 68489182
E-mail: support@arcomnet.com

Internet and Electronic M ail Addresses

ARCOM Web Site: WWW.arcomnet.com
E-Mail: arcom@arcomnet.com
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